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1- Contexte du stage

La protection de la nappe d’eau de Champigny située en lle-de-France est un enjeu important, car
celle-ci assure la distribution en eau potable a prés d'un million de franciliens. Sa recharge s'opére a
70 % par échanges directs a I'interface entre eaux de surfaces et eaux souterraines. Sachant que plus
de 40 % du territoire est drainé, la qualité des eaux rechargeant la nappe est dégradée. La gestion
des eaux de drainage est donc un élément essentiel a considérer.

L'INRAE, Institut National de Recherche pour ['Agriculture, I'Alimentation et I'Environnement,
travaille sur des solutions afin de protéger la nappe de Champigny. Cet institut est né le ler janvier
2020, de la fusion entre I'INRA, Institut national de la recherche agronomique et I'lRSTEA, Institut
national de recherche en sciences et technologies pour I'environnement et I'agriculture (Accueil |
INRAE INSTIT, 2020). Placé sous la tutelle conjointe de nombreux ministeres, I'INRAE est chargé de
réaliser, a son initiative ou a la demande de I'Etat francais, des travaux de recherche scientifique et

technologique.

Fort d'une équipe de 11 523 chercheurs (8 413 agents titulaires et 3 110 agents contractuels) répartis
en 14 départements de recherche, I'INRAE s'impose comme un établissement de référence. Les
subventions obtenues annuellement (notamment par son label Institut Carnot) d'un montant d'un
milliard d'euros, lui permettent la mise en place de nombreuses solutions innovantes (10 000 ha
d’expérimentation, 5721 publications de rang A en 2018).

En 2005, L'IRSTEA devenu INRAE, a été sollicité par Aqui’Brie, association chargée de la protection de
la nappe de Champigny, afin de travailler sur une solution innovante : les zones tampons humides
artificielles (ZTHA).

Méme si l'efficacité de cette solution est connue depuis les années 1990 sur I'abattement des
nutriments, son efficacité vis a vis des pesticides est mal appréhendée et les régles d’ingénierie ne
sont pas encore maitrisées.

Dans le contexte du plan « Life ARTISAN », le projet ANCOEUR 2030 prévoit le déploiement de zones
tampons humides artificielles dans la vallée de I’Ancoeur dans la Brie nangissienne en Seine-et-
Marne. Le bassin versant de 132 km? de I'’Ancoeur présente des enjeux sociétaux liés aux risques
d’inondation des terres agricoles et de dégradation de la qualité des eaux souterraines, ainsi que des

enjeux de protection de la biodiversité en zone agricole.
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2- Objectifs du stage

Dans le cadre de la promotion des Solutions Fondées sur la Nature du projet « Life ARTISAN »,
I'objectif du stage était de dimensionner les Zones Tampons Humides Artificielles (ZTHA) dans le
bassin versant des Effervettes, prés de Nangis en Seine-et-Marne pour prévenir les inondations :
estimer les volumes de rétention et prévoir la gestion de ces ouvrages, quantifier leur apport en
termes de réduction des surfaces inondées. Afin de répondre a ces questions, il a été proposé
d’utiliser les logiciels ArcGIS ainsi que HEC-HMS dans le but de créer un modéle couplant hydrologie

et hydraulique.

Le modele prend en compte les processus de précipitations-ruissellements du bassin versant des
Effervettes. A partir de ce dernier, on peut donc réaliser différents scénarios et comparer lequel
serait le plus apte a répondre aux objectifs du stage.

En résumé, voici les différentes étapes du stage :

e Etablir le modéle hydrologique du bassin versant a partir de HEC-HMS et de son extension
HEC-geoHMS

e Intégrer les ZTHA par une approche simplifiée

e Quantifier I'apport des ZTHA pour réduire les surfaces inondées a I'aval pour différents
modes de gestion hydraulique.

e Discuter de la multifonctionnalité des ZTHA comme solutions fondées sur la nature.

Figure 1 :Vue aérienne du linéaire des Effervettes

h)
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3- Présentation des logiciels utilisés

3 -1 Travail préliminaire sur ArcGIS

L'objectif était donc de mettre en ceuvre le modele sur HEC-HMS qui nous a permis de réaliser les
différents scénarios déja discutés. En effet, en amont du stage un premier travail sur SIG a permis
d’identifier les emplacements possibles des ZTHA couplant les trois services écosystémiques sur une
surface totale de 170 ha.

Nous avons utilisé I'outil HEC-geoHMS du logiciel ArcGlIS, les deux en version 10.8 pour débuter la

création du modeéle.

HEC-GeoHMS est une extension qui a été développée comme une boite a outils d'hydrologie
géospatiale pour les ingénieurs et les hydrologues ayant une expérience limitée d’ArcGlIS. Elle utilise
ArcGIS pour créer un systeme de modélisation hydrologique et aide a visualiser l'information
spatiale, de documenter les caractéristiques des bassins versants, d'effectuer des analyses spatiales
et de délimiter les sous-bassins et les cours d'eau. En outre, I'extension permet de créer rapidement
des données hydrologiques afin d’étre exportées sur HEC-HMS.

0 900 1800 3 600 Métres
| B T T N TR N -

Figure 2 : Bassin versant obtenu a partir de HEC-geoHMS

Le travail fait a partir de HEC-geoHMS est en fait du preprocessing: on a extrait les données

hydrologiques du linéaire (voir guide annexe).
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3-2 Modélisation sur HEC-HMS

HEC-HMS est congu pour simuler les processus hydrologiques complets des systéemes de bassins
versants dendritiques. A partir des données exportées depuis HEC-geoHMS, on peut créer un projet
oUu on pourra réaliser les simulations a partir des hypotheses établies qui sont détaillées ci-dessous.
Le logiciel est en version 4.9.

4- Hypotheses sur le modele

e Hypotheses sur le fonctionnement hydrologique du bassin :

Loss Method -> Afin de modéliser la redistribution de la pluie sur le bassin versant, on a choisi la
méthode du SCS Curve Number. Ce modele estime I'exces de précipitations comme une fonction des
précipitations cumulées, de la couverture des sols et de I'humidité initiale du sol. On estime que le
Curve Number se rapprochant le plus du type de sol présent a Rampillon, en se basant sur la
littérature est de 70 avec une imperméabilité de 5%.

e Hypothéses sur les précipitations du modele :

On considére que la pluie est homogéne. On a obtenu les données pluviométriques venant de Safran
sur une période allant du 01 ao(t 1958 au 31 juillet 2020 au pas de temps journalier. Cependant, on
regarde ici que I'année hydrologique d’octobre 2015 a septembre 2016 car elle fait part d’'une crue
importante au mois de mai 2016, qui nous aide a mieux visualiser si le modéle est cohérent. De plus,
I’évapotranspiration est aussi prise en compte, les données venant aussi de Safran.

e Hypotheéses sur les bassins de rétention :

Au niveau de leur fonctionnement hydraulique, les bassins de rétention sont placés en paralléles,
pour une question de réglementation liée a la loi sur I'eau. Dans le modele, tous ces bassins
comportent un systéme de surverse.

Au niveau du dimensionnement, on opte pour un bassin d’une hauteur de 2 meétres et d’une section
rectangulaire de 5 metres. On choisit ces dimensions afin de travailler sur un modele simple dans un
premier temps, qui pourrait étre amené a étre amélioré par la suite.

Concernant le débit de sortie Qmax de ces bassins, on se base sur la période de retour décennale ou
I’'on prend un débit de 3 m3/s.

UNIVERSITE
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Figure 3 : Schéma du bassin de rétention

5- Simulations

5-1 Validation du modele

La validation du modeéle s’est faite a partir des données d’HydroPortail. On compare les données de
débits moyens journaliers obtenus par simulation et celles de la station « Le rue d’Ancoeur » a
Blandy. Cette station a été choisie car elle recouvre le bassin versant des Effervettes, avec une
surface de 181km?, comparé au 13km? du modéle. On compare sur "année hydrologique 2016 car on
a la présence d’une crue importante, qui aide a mieux visualiser les différences.
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Figure 4 : Comparaison des chronigues sur |I'année hydrologique de 2016
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On remarque tout d’abord que le modéle sur HEC-HMS est plus réceptif que les mesures de la station
de BLANDY. En effet, en dehors de la période de crue importante en mai 2016, on obtient des
chroniques plus importantes. On imagine que cela est di a une mauvaise capacité d’infiltration du
sol décrite dans le modele, notamment a travers le Curve Number. Mais méme en modifiant
significativement ce nombre, on obtient les mémes résultats. Ainsi, le modéle reste tout de méme
valide car pour la crue de mai 2016, on retrouve la forme de I’'hydrogramme de la station de BLANDY.
On retient donc la valeur du débit Q = 8 m3/s

5-2 Reésultats et discussions

On a pu lancer deux simulations : dans la premiere, on place un unique bassin de rétention en
parallele a une centaine de metres en amont de I'exutoire. Dans la seconde, on place plusieurs
bassins en paralléle tous les 1 km. Pour chaque graphique, on compare le débit moyen journalier non
glissant a I'exutoire. Pour rappel, le bassin a une surface de 13 km?

Subbasin-1

Figure 5 : Représentation de la premiére simulation sur HEC-HMS

UNIVERSITE
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Subbasin-1

Figure 6 : Représentation de la seconde simulation sur HEC-HMS
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Sans bassin de rétention Avec un bassin de rétention

Figure 7 : Comparaison des chronigues avec et sans bassin de rétention

On voit bien que le débit diminue de maniere significative sur toute la période. On remarque que de
maniére général, il baisse de 1 m3/s pour les périodes de crue importantes et de 0.5 m3/s pour le
reste, qu’on ne tient pas en compte car le modele décrit mal ces périodes. En plus de I'écrétement de
I’hydrogramme a I'exutoire, on observe un léger laminage des crues.
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Ensuite, avec la seconde simulation, on a cherché a voir si le débit moyen diminuait en plagant
plusieurs bassins de rétention en paralléle. On a choisi d’en placer 4 en amont de I'exutoire a chaque
kilometre, afin de pouvoir observer une réelle différence dans I’hydrogramme de sortie :

Débitmoyen journalier nonglissant {m?3/s)
IS

juin-16 aolt-16 oct.-16

Date (TU)

Sans bassin de rétention

Avec 4 bassins de rétention

Figure 8 : Comparaison des chronigues avec 4 et sans bassins de rétention

De la méme maniére que pour la simulation avec un unique de bassin de rétention, les débits
journaliers sont plus faibles mais ici, on remarque qu’ils sont deux fois moins importants. De plus, le
laminage des crues est beaucoup visible et durable.

Maintenant, il faut voir s’il y a une différence majeure entre placer un seul bassin de rétention ou
plusieurs et aussi discuter de la réalité du foncier.
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Figure 9 : Comparaison des chronigues avec 4 et 1 bassins de rétention

On peut voir que les débits moyens journaliers ne semblent pas diminuer grandement en dehors de
la crue de mai 2016. Cependant, on observe bien une différence dans le laminage des crues. On peut
donc se poser la question si rajouter plus de bassins de rétention aurait vraiment un impact sur la
limitation des zones inondables a I'aval. On voit déja que mettre en place un seul bassin de rétention
en paralléle permet déja d’atteindre I'objectif de réduire le risque d’inondation.

5 -3 Pistes pour la suite

L'utilisation de I'extension HEC-GeoHMS et du logiciel HEC-HMS pour modéliser la mise en place de
ZTHA dans le bassin versant des Effervettes s’est avérée plutdt efficace méme si le modele n’est pas
validé en totalité.

Une des pistes de réflexion envisageable serait I'étude de la fonction de traitement des eaux des
ZTHA. En effet, il serait intéressant de dimensionner et intégrer ces zones en vue d’augmenter le
temps de séjour de 'eau stockée afin qu’elle soit traitée, avec en complément des études portant sur
la dissipation de pesticides et des nitrates dans les ZTHA. Il s’agissait d’un des objectifs du stage, mais
durant le stage il y eu des problémes avec les outils utilisés notamment leur installation, leur
comptabilité entre eux et I'exportation des données ce qui a ralenti I'étude.
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6- Annexes

6-1 Guide de développement d’un modele HMS a l'aide de
HEC-GeoHMS

Dans ce guide, il est expliqué précisement comment développer le méme modele décrit dans ce
rapport, de la pré-modélisation a partir de I'extension HEC-GeoHMS jusqu’au lancement des
simulations sur HEC-HMS.

e Ajouter I'extension HEC-GeoHMS et Arc HydroTools a la barre des taches :

Sélectionner I'onglet Customize -> Toolbars -> Hec-GeoHMS et Arc HydroTools

e Terrain Preprocessing :

Dans le menu de I'extension HEC-GeoHMS, sélectionner dans 'ordre les outils suivants : DEM
Reconditioning, Fill Sinks et le reste de la liste.

Au final, on doit obtenir le jeu de données décrit ci-dessous.
Données raster :

. Raw DEM (Cedar_dem)

. HydroDEM (Fil)

. Flow Direction Grid (Fdr)

. Flow Accumulation Grid (Fac)

. Stream Grid (Str)

. Stream Link Grid (StrLnk)

. Catchment Grid (Cat)

. Slope Grid (WshSlope)

Données vectorielles :

0N OV WN R

1. Catchment Polygons (Catchment)
2. Drainage Line Polygons (Drainageline)
3. Adjoint Catchment Polygons (AdjointCatchment)

e Création du projet HMS

Avant de créer le projet HMS, on vérifie le jeu de données. Pour cela, dans le menu HMS
sélectionner Project Setup -> Data Management.

Pour créer le projet, sélectionner Project Setup -> Start New Project. Ensuite, il faut définir un
point projet a partir de I'outil Add Project Points, qui correspond a I'exutoire. Aprés cela, on peut

générer le projet avec Project Setup -> Generate Project.

h)
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e Extraction des caractéristiques du bassin versant

On extrait les caractéristiques du bassin versant délimité au préalable a partir du menu
Characteristics puis en sélectionnant toutes les caractéristiques du menu.

e Paramétrage HMS

On peut choisir dés maintenant les parametres de ruissellement du bassin versant, méme si on
peut les modifier par la suite directement sur HEC-HMS. Pour ce faire, sélectionner Parameters ->
Select HMS Processes. On détaillera par la suite les méthodes et les parametres choisis dans
notre cas.

Pour faciliter notre travail, on utilise les fonctions River Auto Name et Basin Auto Name qui
permettent d’assigner des noms aux segments de riviere et aux sous-bassins. Sélectionner
Parameters -> River Auto Name et Parameters -> Basin Auto Name.

e Exportation des données pour le modeéle HEC-HMS

Tout d’abord, on convertit les unités. Sélectionner I'onglet HMS -> Map to HMS Units. Puis, il faut
vérifier les données avec HMS -> Check Data. Pour étre slr qu’il n’y ait pas d’erreurs, on peut
ouvrir le fichier log crée.

Pour préparer les données a étre exportées vers HEC-HMS, sélectionner HMS -> Prepare Data for
Model Export. Afin d’obtenir les .shp de fond de carte, sélectionner HMS -> Background Shape
File. Grace a cette fonction, on a les fichiers River1584.shp et Subbasin1584 qui seront utilisés
dans HEC-HMS.

Finalement, pour exporter le modele hydrologique sélectionner HMS -> Basin Model File, créant
ainsi le fichier .basin, qu’on importera dans HEC-HMS.

e Ouvrir le modéle HEC-HMS

Pour ouvrir le modele sur HEC-HMS, sélectionner File -> New, créer un projet. Puis, pour
importer le modeéle que nous avons réalisé, sélectionner File -> Import -> Basin Model et
chercher le fichier .basin crée. Pour obtenir le fond de carte, sélectionner I'onglet View ->
Background Map et ajouter les fichiers River1584.shp et Subbasin1584.

e Simulation sur HEC-HMS

Maintenant, il faut rentrer les parameétres hydrologiques afin de pouvoir obtenir une simulation.
Pour cela, il est nécessaire de créer 4 composantes :

- Le modele du bassin (déja obtenu en important le fichier .basin)
- Le modele météorologique

- Les données de suite temporelle (données pluviométriques)

- Une composante de controle

UNIVERSITE
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6 -2 Autres simulations
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Figure 10 : Comparaison des chronigues entre 10 et 4 bassins de rétention
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Figure 11 : Comparaison des chronigues entre 10 et sans bassins de rétention
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